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Lab 1

Line tracking control & line maze solving
strategies for the 3pi+ mobile robot

This lab aims first to study and design different control strategies for a line following robot so
that it is able to track a black line that is drawn on the surface. The second objective is to
study, develop and implement a line maze solving algorithm.

1.1 A few short videos to start with

Line tracking has become the most convenient and reliable technique by which autonomous
mobile robots can navigate in a controlled, usually indoor, environment. The path of the robot
is demarcated with a distinguishable line or track, which the robot uses to navigate.

In the industry, vehicles are often required to carry products from one manufacturing plant
to another which are usually in different buildings or separate blocks. Conventionally, carts or
trucks were used with human drivers. Unreliability and inefficiency in this part of the assembly
line formed the weakest link. Solution based on automated guided vehicle following a line,
instead of laying railway tracks which can be more costly, are nowadays available as shown in
Figure 1.1.

Figure 1.1: Example of automated guided vehicle in the industry

You can also see the automated guided vehicle in action by watching the short video
available at: www.youtube.com/watch?v=WIlS3vNSuQ4
Automated guided vehicles following a magnetic line have become of common use at Tesla
Mega factories as explained by Elon Musk: youtu.be/mr9kK0_7x08&t=6m43s?

Many line following competitions have been organized by clubs of robot building enthusi-
asts over the last two decades. The goal of these racing competitions is usually to build an
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autonomous robot that does a certain number of laps of a test track the fastest. Watch, for ex-
ample, the video that shows six 3pi robot running simultaneously on the same line-race course.
Each robot was programmed independently, but as we can see, the results were remarkably
consistent. The last one on the line wins!
www.youtube.com/watch?v=fl0CJhPiEfYt=76s
We will try to reproduce this contest in your group by using the same type of robots.

1.2 Pre-lab questions

There are no pre-lab questions for this lab.

1.3 The 3pi+ mobile robot from Pololu

The 3pi+ 32U4 robot is a high-performance, user-programmable robot that measures just 9.7
cm in diameter. The brain of the robot is an integrated, USB-enabled, Arduino-compatible
ATmega32U4 microcontroller from Atmel, clocked by a precision 16 MHz crystal oscillator.
The 3pi+ robot comes preloaded with an Arduino-compatible USB bootloader which allows it
to be easily programmed using the Arduino IDE.

1.3.1 Hardware required

Figure 1.2: Front view of the 3pi+ robot from Pololu

The required hardware for this lab includes:

• a 3pi+ Robot from Pololu as shown in Figure 1.2;

• a USB A to Micro-B cable to connect the robot to your computer for programming and
debugging. The USB connection can be used to transmit and receive data from the
computer and program the board over USB;

• four rechargeable AAA NiMH batteries;

• a battery charger (in case your batteries are discharged before the end of the lab);

• a basic track for initial test and a racing competition track which has the form of the F1
Estoril course in Portugal shown in Figure 1.3.
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Figure 1.3: Tracks used for initial basic tests and for the racing competition

1.3.1.1 Version of the 3pi+ 32U4 robot

Three different versions of the assembled 3pi+ 32U4 robots exist. They are equipped with
different motors which will impact the maximum speed of the robot. They can be identified
with a sticker on the underside of the main board, visible inside the battery compartment of
the 3pi+ without batteries installed. The color of the sticker indicates the gear ratio of the
robot’s motors:

• Green: 50:1 HP

• Blue: 75:1 HP

• Red: 100:1 HP

From the user guide available at: www.pololu.com/docs/0J83

• Determine the version of your 3pi+ 32U4 robot: standard, turtle or hyper edition;

• Find the maximum speed in m/s for your 3pi+ 32U4 robot.

1.3.1.2 On/off and user pushbuttons

Figure 1.4: Top view of the 3pi+ robot showing its main components
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The 3pi+ 32U4 control board has five pushbuttons: a power button on the left, a reset button
on the right, and three user pushbuttons, labeled A, B, and C, located at the rear close to the
USB programming interface as shown in Figure 1.4.
Pushbutton B will be mainly used for calibrating and running the 3pi+ robot. At the bottom
left side of the LCD display, there is the soft power button to switch on or switch off the 3pi+
robot. On the right side of the LCD display, there is the reset button that can be used to reset
the board (you should not need to use it).

1.3.2 Operating system and software required

1.3.2.1 Operating System required

The 3pi+ 32U4 robot can be programmed from a computer using any operating system that
supports the Arduino environment. This includes Microsoft Windows 11, 10, 8.1, 8, 7, Vista,
XP (with Service Pack 3), Linux, and Mac OS X.

1.3.2.2 Software required

The Arduino Uno interface will be used to implement and test different open-loop and closed-
loop control algorithms. To get started with your 3pi+ robot, follow the instructions given
below. They are more detailed in Section 6. Programming the 3pi+ 32U4 of the 3pi+
robot user guide which can be downloaded from www.pololu.com/docs/0J83.

1. If necessary, download and install on your PC the Arduino compiler from
www.arduino.cc/en/Main/Software.

2. To help interface with all the on-board hardware on the 3pi+ 32U4, Pololu has provided
the 3pi+32U4 library. If not already installed, install the 3pi+ 32U4 Arduino library by
following carefully all the instructions given in www.pololu.com/docs/0J83/6.2.
Depending on your Arduino version, you can also try the following: from Arduino, go
to the Sketch menu, select Include Library, then Manage Libraries..., then search for
3pi+32U4 and install the library.

1.3.3 Identification of the physical system components of the 3pi+

Prior to operating any experimental system, it is imperative to familiarize yourself with the
various components of the system. Part of the process involves the identification of the individ-
ual hardware components, including its sensors and actuators. Find out from the description
given below more detail about the individual hardware components of the 3pi+ robot.
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1.3.3.1 The line sensors

Figure 1.5: Underneath view of the 3pi+ robot. The IR line sensors are placed at the front.

The 3pi+ line sensor array is a separate board that attaches to the main underneath board,
placed in front of the robot as shown in Figure 1.5. The board features five line sensors
connected to the microcontroller. The five line sensors face downward and can help the 3pi+
robot distinguish a non-reflective (black) line on a reflective (white) surface. Each reflectance
sensor consists of a down-facing analog infrared (IR) emitter LED (Light-Emitting Diode)
paired with a phototransistor that can detect reflected IR light from the LED. Three of
the five sensors are placed in the middle of the board at gaps of about 10 mm and the last
two are situated at the far end of both sides such that the total sensor coverage is about 60 mm.

The line IR sensors are just an indication of surface reflectivity. The sensor value is lower
when over a white surface and higher when over a dark surface. The actual values are heavily
dependent on the external lighting conditions even though sensor array is shielded. Further-
more, there is appreciable difference between the readings of various sensors due to various
factors like placement, manufacturing differences, etc.
To get usable values from all the sensors, the sensor values are normalized for environmental
conditions and sensor differences and the normalization values are stored in Data Flash of the
microcontroller. This enables the normalization data to be used multiple times. To normalize
the sensor values, the robot is placed on the track and rotated such that all the sensors pass
over the black and white surfaces. The maximum and minimum readings for all the sensors are
noted down and stored in non-volatile memory (Data Flash) of the microcontroller.

The lineSensors.readLine(lineSensorValues) function returns a value between 0 and
(number_of_sensors) - 1)×1000. As the 3pi+ 32U4 robot has an array of 5 sensors, the
reading will be 0-4000. 0 represents the left most sensor and each increment of 1000 after
that represents another sensor. 0 = first sensor, 1000 = second sensor and there are ranges in
between as well. 500 means the line is between the first and second sensors, 1200 means it’s
between the second and third sensors but closer to the second, etc. Note that if the reading is
2000, it means that that the robot is centered on the line.
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This output of the IR line sensor array is fed to the microcontroller which calculates the
error term between the sensor value and the line position setpoint. The most convenient and
reliable way to compute the error term is by dividing the weighted average of the sensor readings
by the average value and normalizing the values. The formula used to compute the error ε(k)
at time-instant k is given as follows:

ε(k) = 1000×
∑4

i=0 i× Li(k)∑4
i=0 Li(k)

− 2000

In the equation above, Li(k) refers to the output of the i-th line sensor in the array. Here,
1000 is the normalizing factor which is used to ensure that the contribution of the error term
from each sensor is normalized to a value of 1000. The subtraction by 2000 is to ensure that
zero error occurs when the robot is centered on the line.
The sensors are numbered from the left to the right. An error value of zero refers to the robot
being exactly on the center of the line. A positive error means that the robot has deviated to
the left and a negative error value means that the robot has deviated to the right. The error
can have a maximum value of ±2000 which corresponds to maximum deviation.
The main advantage of this approach is that the five sensor readings are replaced with a single
error term which can be fed to the control algorithm to compute the motor speeds such that
the error term becomes zero. Further, the error value becomes independent of the line width
and so the robot can tackle lines of different thicknesses without needing any change in code.

1.3.3.2 The actuators

The robot is driven by two micro metal gearmotors with extended motor shafts, coupled to
wheels. It is battery powered, with the motors supplied with regulated power supply to ensure
consistent motor power at all operating scenarios. The robot can reach a maximum speed of
about 1.5 m/s.

A simplified diagram of the 3pi+ mobile robot is presented in Figure 1.6 where

• L is the distance between two wheels,

• R is the radius of each wheel,

• ωl is the rate (or speed) at which the left wheel is turning,

• ωr is the rate (or speed) at which the right wheel is turning.
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Figure 1.6: Simplified diagram of the two wheel mobile robot.

The 3pi+ robot is a differential drive robot. It contains two wheels each of which is
equipped with a separate DC motor that controls its rotation. For this system, the two inputs
are going to be ωr and ωl, i.e., rates at which left and right wheel are turning. This robot
is called differential drive because the steering of this system is based on difference in the
turning rates/speeds of the two wheels.

To move the robot forward, both motors are rotated at a given nominal speed in the forward
direction. To make the robot turn to the left or to the right, the speed of one motor is reduced
while the speed of the second motor is increased by the same value. The amount of turn
increases as the speed difference increases. Maximum amount of turn is achieved when one
motor is turned in a backward direction at maximum speed, the other in the forward direction
at maximum speed. This results in maximum speed difference and the robot just spins in place.

1.3.4 Test of a basic control in open loop

The system characteristics can be better understood by considering an open-loop test on the
line tracking system:

1. Assume that the robot is placed exactly on the centre of a straight line and exactly in the
direction of the line. If both motors run at equal speed, the robot moves forward with
zero error. This is the only special condition where zero control effort is needed.

2. If there is any discrepancy, line not being exactly straight, robot not being perfectly
aligned or the existence of speed difference between the motors, control effort is needed
(speed of one of the motors must be reduced while the speed of the second motor must
be increased).

3. Now, assume that the robot is away from the centre of the line by some distance. In order
to reduce the error, a control effort must be given as illustrated in Figure 1.7. However,
the sending of a constant control effort will cause the robot to overshoot the line.
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Figure 1.7: Open-loop test to illustrate the required control effort to steer the robot over the line.

We will first test how to control in open loop the 3pi+ robot by setting manually (in open-
loop) the speed command of both right and left wheels. Follow the instructions below:

1. From the Arduino IDE, open the File menu, select New, then enter the code below:
]include <Pololu3piPlus32U4.h>
]include <PololuMenu.h>

using namespace Pololu3piPlus32U4;

Motors motors;

void setup()
{
delay(5000); // wait for 5 seconds before starting the basic control in
open loop
}
void loop()
{int16_t rightSpeed = 50; // Set a nominal 50 speed command to both
//wheels
int16_t leftSpeed = 50; // The sign determines if the robot goes forward
// or reverse.
motors.setSpeeds(leftSpeed,rightSpeed);
}

2. Connect the 3pi+ robot to your PC through the USB cable.

3. In the Tools menu, select Board menu, then Pololu A-Star 32U4 entry.

4. In the Tools menu, select Port menu, select the port for the device.

5. Press the Upload button to compile the sketch and upload it to the device. If everything
goes correctly, you will see the message Done uploading appear near the bottom of the
window.

6. Disconnect the 3pi+ robot and switch it on by pushing the power button of the robot,
on the left of the LCD display.

7. Place the 3pi+ robot over the straight black line of the Estoril racing track. The robot
should start at a fairly low speed. You might notice it is not driving in a straight line.
That is the unfortunate consequence to real life: the same command to each motor might
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actually be driving them at slightly different speeds or may be one wheel is making better
contact with the ground. Anyway, you can see that the robot is doing pretty much exactly
what you thought it would do.

8. Catch the robot and switch it off.

9. Modify to left motor speed to the nominal value 50 + 10 = 60 and the right speed to the
nominal value 50 - 10 = 40.

10. Compile the program and upload it to the 3pi+ robot. Repeat the open loop control test
and observe if the robot is now turning left or right ? Does it make sense ?

From this simple open loop test, you should have understood how you can control the robot
direction by adjusting the speed difference between the 2 wheels from a given nominal speed
command. The goal will be to design different control strategies to set automatically the speed
difference command (manually chosen arbitrarily to 2 × 10 above) from a given nominal speed
command.

1.3.5 Characteristics of the robot line following from a control system
perspective

To achieve good performance, there is a need to better examine the characteristics of the robot
line following from a control system perspective. This should help for tuning the different
gains of the PID controller.

When the robot is placed on a straight track, it was observed that the robot was able to
stay centered over the line. This proves that the steady state error is zero for a straight line.
When the robot is placed on a curved track, it was seen that the robot overshoots the line
centre by a greater amount in the direction opposite to the direction of curvature of the track.
Further, it was observed that, as the curvature increases, the difference in overshoots increases.
This proves that a steady state error exists when the track is curved.
For the closed-loop system, the setpoint is always constant and set to 2000 so that the robot
stays on the centre of line. However the track does not remain straight and so the line
curvature should be considered as an external disturbance for the control system. Now, it
can be concluded that, when the system has zero or negligible disturbance (analogous to a
step input for a simple unity feedback system), the steady state error (position error) is zero.
When a significant disturbance exists (analogous to a ramp or parabolic input for a simple
unity feedback system), the steady-state error (velocity and acceleration errors) is significant.
From the above discussion, it can be concluded that there are at least one integrator in the
feedforward path of the control system.
From the above considerations, it can be understood that the open loop response of the system
thus resembles that of a servo position control system. Thus, the control techniques used for
servo position control may be applicable for the line tracking robot.

The closed-loop block diagram of the wheeled mobile robot based on differential drive
mechanism is shown in Figure 1.8. The thick solid line from the sensor block represents the
multiple feedback signals from the (5 here) sensors.
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Figure 1.8: The system block diagram based on differential drive mechanism.

To control the differential drive mobile robot direction, the controller has to deliver the two
wheel speed/rotation ωr and ωl. However, for the control design, it is not convenient to think
in terms of wheel rotations. As seen from the open-loop test, a more natural set of control
command is to use the speed difference command sent to both motors from a nominal value
for the speed command. The block diagram of the closed-loop control for the 3pi+ robot is
displayed in Figure 1.9. Note the important role of the nominal value for the speed command
which has to be set initially by the user. The two motor speeds are set depending on two
command signals: the controller output and the nominal speed, which determines the speed at
which the robot is running on straight line.

Figure 1.9: Block diagram of the closed-loop control for the 3pi+ robot.
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1.3.6 Control performance requirements

The performance requirements for the line following control are the following:

The robot is expected to track the line faithfully without any problems. The robot should
not leave the line at any instant and the movement of the robot should have minimum overshoot
and all the movements should be smooth meaning that the robot must not have zigzagging and
jerky movements.

In terms of performance, a first objective is to make the 3pi+ mobile robot move forward
at the fastest speed (nominal speed greater than 250) so that it can complete one lap of the
basic track in the shortest time possible. The second objective, if time allows, is to make
the 3pi+ mobile robot complete two laps of the racing competition track at a moderate
nominal speed of 200.

1.4 Control strategies for the robot line tracker on the ba-
sic test track

A simplified version block-diagram of the feedback control for the robot line tracker is shown
in Figure 1.10.

C(s) G(s)

GD(s)

2000 + ε(s) U(s) + Θ(s)

−

D(s)

+

Figure 1.10: Simplified block-diagram of the feedback control

1.4.1 Download of the files required for closed-loop control

1. Download the zipped file Lab3.zip from the course website and save and unzip it in your
preferred working folder.

1.4.2 Test of a P controller in closed loop

We will now test a closed loop control by using a simple Proportional controller to make the
3pi+ robot track the black line of the basic test track which takes the following form:

C(s) =
U(s)

ε(s)
= kp

where kp refers to the proportional gain constant.

The P controller equation in the time-domain is given as

u(t) = kp × ε(t)
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Find in the Lab3.ino program, the line which implements the P controller equation.

Note that for this simple P control strategy, you will need to select a nominal speed
(∈ [100; 300]) at which the robot will travel. If the selected nominal speed is too high and or
the proportional gain is badly tuned, the robot will not be able to stay on the track.

Follow the instructions below:

1. From the Arduino IDE, open the File menu, open the program named Lab3.ino from the
zipped file downloaded from the course website. Verify that the variable nominalSpeed
is set to 100;

2. Connect the 3pi+ robot to your PC through the USB cable.

3. In the Tools menu, select Board menu, then Pololu A-Star 32U4 entry.

4. In the Tools menu, select Port menu, select the port for the device.

5. Press the Upload button to compile the sketch and upload it to the device. If everything
goes correctly, you will see the message Done uploading displayed at the right bottom of
the window.

6. Disconnect the 3pi+ robot and switch it on pushing the power button on the left side of
the LCD display.

7. Place the 3pi+ robot over the black line of the basic test track and press the B-button.
The robot will make two turns to start the automatic sensor calibration step by rotating
in place to sweep the sensors over the line.

8. Prepare your smartphone to measure the time it takes for the 3pi+ robot to complete one
lap. When you are ready to start the time, press again on the B-button and let the robot
follow the line. Stop the time when the robot has complete a full lap, if it can make it !
Record the time that will constitute the reference time to be improved.
You should observe that the simple P controller works reasonably well for this relatively
slow nominal speed.

9. Place now the 3pi+ robot over the black line of the racing competition track and test if
the robot is able to complete one full lap.
If this is not the case, try to reduce the nominal speed and test if the robot is able to
achieve one full lap without leaving the line in the sharp curved area. To achieve better
performance, there is a need to better understand how the control of the two motor speeds
work.

10. From the example program and comments given inside, determine the main command to
be controlled and the two variables used to steer the 3pi+ robot.

11. Give the control equation for both left and right motor speeds.

12. Determine the setpoint value for the line position.

13. Determine the role of the variable nominalSpeed.
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14. Build a block-diagram of the simple P controller for the robot line follower, showing a
block for the actuator, the robot, the sensor and the controller.

15. Modify the proportional gain of the controller so that the robot can complete one lap of
the basic test track in the shortest time possible. Once the robot is following the line with
good accuracy, increase the nominalSpeed variable to 200 and 300 (50%, and 75% of
its maximum value respectively) and see if it is still able to follow the line (this might not
be the case for 300). Note that the robot nominal speed affects the P controller tuning
and will require its retuning as the nominalSpeed changes.

Gather the performance of the different P controllers by completing the first three lines of
Table 1.1.

nominalSpeed Controller Kp gain Kd gain Completion time for one lap (sec)

100 (25%) P controller /

200 (50%) P controller /

300 (75%) P controller /

200 (50%) PD controller

300 (75%) PD controller
Table 1.1: Performance of the various P and PD controllers on the basic track

1.4.3 Test of a PD controller in closed loop

One of the most popular control technique for servo position control takes the form of a PD
controller of the following form:

C(s) =
U(s)

ε(s)
= kp + kds

where kp and kd refer to proportional and derivative gain constants respectively.

1.4.3.1 Finding best values of the PD controller

The PD controller equation in the time-domain is given as

u(t) = kp × ε(t) + kd ×
dε(t)

dt

For digital implementation, the time-derivative of the error term can be approximated by
using the backward Euler method.

u(k) = Kp × ε(k) + Kd ×
(
ε(k)− ε(k − 1)

)
(1.1)

where Kp = kp and Kd =
kd
Ts

; Ts being the sampling period. u(k) denotes the command value

at time-instant t = kTs.
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Note that the sampling time, Ts, is simply eliminated from the control equation because it is
embedded in the new derivative gain Kd.

Finding the best values of the PD controller, i.e., Kp and Kd values, is now the most
important challenge for you. There is unfortunately no simple way to get a model of the robot
from an open-loop test with a nominal speed of 200, which could serve as the basis to tune
the PD controller gains. The latter will therefore be tuned in this lab by a trial and error
method only. These gain values are expected to be different for every group of students and
for the nominalSpeed variable setting, which determines the speed at which the robot is running.

Using a trial and error methodology to set the gains of a PD controller has some advantages
(no need to determine a model, ...). The bad side of it is that you must re-compile the program
each time that you change the gains.

You might want to try this empirical method for the tuning of the PD gain controller:

• Modify the initial program to implement a PD control given in (1.1) instead of the simple
P control. In the File menu, select Examples entry, then Pololu3piPlus32U4 entry and
open the LineFollowerPID.ino file available which implements a PD controller. Find and
understand the line which implements the PD controller equation. Implement all the
needed code in your initial program.

• Set the nominalSpeed variable to 200 (50% of its maximum value).

• Set the Kd gain to 0 and tune the Kp term alone first. If the robot cannot navigate a
turn or reacts too slowly, increase its value. If the robot seems to react fast leading to a
zigzagging behavior, decrease the value.

• Then set your Kd gain value to 10 to 100 times of the Kp value and check if the robot
can navigate in a better way than with the simple P controller. Increase the derivative
gain Kd to decrease the overshoot (of the line), decrease it if the robot become too jerky
or is not able to remain on the line.

• Once the PD controller tuning make the 3pi+ robot follow the line with good accuracy,
record the time that will constitute the best time for the PD controller at 50% of the
maximum value of the robot speed.

• Once the robot is following the line with good accuracy, increase the nominalSpeed
variable to 300 (75% of its maximum value respectively) and see if it still is able to follow
the line. Note that the robot speed affects the PD controller and will require retuning as
the nominalSpeed changes.

• It is worth noting that the tuning of the PD controller gain might not be possible for the
maximum speed setting without additional modification of the control algorithm so that
the speed of the robot is dynamically reduced/increased depending on curvature of the
track, as we do when we drive a car !

1.4.4 Performance summary of the different controllers on the basic
test track

Gather the performance of the different controllers by completing Table 1.1.
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1.5 Control strategies for the robot line tracker on the rac-
ing competition track

From your initial experience obtained from your test with the basic track, tune the PD controller
the best you can so that your robot can traverse the Estoril racing track as fast as possible.
Gather the performance and tuning value of the best PD controller in Table 1.2.

Note that the Estoril track is much more challenging that the basic track since it includes
a difficult curved area which requires a low speed to keep the robot on the track. The nominal
speed of the robot should therefore be set to small or moderate value for the robot to be able
to do handle this curve and complete a full lap.

nominalSpeed Controller Kp gain Kd gain Completion time for one lap (sec)

100 (25%) PD controller

200 (50%) PD controller
Table 1.2: Performance of PD controller on the racing track

1.6 More sophisticated control strategies to improve per-
formance

You will now explore some possible improvements to get better line tracking performance of
your robot.

The final goal would be to develop a more sophisticated gear-shifting control strategy for
your robot to dynamically adjust its speed while traversing the track to travel as fast as possible
on less challenging portions of the track (in the long straight line for example) while slowing
down in difficult curved areas to maintain control.

1.6.1 Addition of dynamic speed variation

A first improvement to be tested consists in adding a speed reduction term in the control
equation of both motor speeds so that the robot can navigate at a higher speed in the straight
path and slows down slightly at turns so that stability is maintained. For example, the speed
reduction term to be subtracted from the control equation, can be of the form:

SR(k) = Ksr ×
9∑

i=0

|ε(k − i)|

where Ksr should be tuned from a small value and gradually increased until overshoot is
acceptable for curved paths and turns.

If the proposed strategy is not successful, move on to the next subsection where another
more advanced cascade control strategy is suggested.

1.6.2 Addition of an integral action in the controller

The last attempt would be to add an integral term to your PD controller where only the last ten
error values are summed up instead of adding all the previous values. The modified controller
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equation takes then the form:

u(k) = Kp × ε(k) + Ki ×
9∑

i=0

ε(k − i) + Kd ×
(
ε(k)− ε(k − 1)

)
where Ki = ki × Ts is the integral gain of the discretized version of the PID controller in
parallel form by the backward Euler method. Set Ki to a very small value and then gradually
increase it until overshoot is acceptable for curved paths and turns. Modify the width
of the moving window (set to 10 above) to compute the integral term if this is necessary.
The addition of the integral action might not lead to improvements for this robot and test track.

If the previous suggested improvements were not successful, you are free to propose and
implement some more elaborated control strategies.

1.7 Solving a line maze
The next step up from simple line following is to teach your 3pi+ to navigate paths with
sharp turns, dead ends, and intersections. Make a complicated network of intersecting black
lines, add a circle to represent the goal, and you have a line maze, which is a challenging
environment for a robot to explore.

In a line maze contest, robots travel as quickly as possible along the lines from a designated
start to the goal, keeping track of the intersections that they pass along the way. Robots are
given several chances to run the maze, so that they can follow the fastest possible path after
learning about all of the dead ends.

See the tutorial for solving a maze available at: www.pololu.com/docs/0J21/8.a.
The mazes solved in this tutorial have one special feature: they have no loops. That is,

there is no way to re-visit any point on the maze without retracing your steps. Solving this
type of maze is much easier than solving a looped maze, since a simple strategy allows you to
explore the entire maze.

For information on building your own course such as the one displayed in Figure 1.11, see
the tutorial on Building Line Maze Courses available at: www.pololu.com/docs/0J21/8.a.

Figure 1.11: Example of line maze course

An additional resource for understanding simple, non-looped maze solving is the presenta-
tion written by Professor R. Vannoy also available from the website given above. It does not
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include any code, but it goes over some important concepts and contains a number of visuals
to help illustrate the important points.

Follow the tutorial, build your own course and implement a line maze solving algorithm for
the 3pi+ robot.
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1.8 Troubleshooting

1.8.1 If you cannot upload any script to the 3pi+ robot

1.8.1.1 The double reset method

1. Connect the 3pi+ device to your computer via USB.

2. In the "Tools" menu, open the ?Board? sub-menu and select "Pololu A-Star 32U4".

3. In the "Tools" menu, open the "Port" sub-menu and select the appropriate port.

4. Compile the file and reset the board by pressing twice on the reset button.

1.8.1.2 The uploading-before-bootloader method

The goal of the uploading-before-bootloader method is to select a non-existent serial port in
the Arduino IDE and then make sure the Arduino IDE enters the uploading phase before the
microcontroller goes into bootloader mode.
This method has been tested on Arduino 1.8.19 but it does not work on Arduino 2.0.0 or 2.0.3
(and probably does not work on any 2.x versions) because those versions of the IDE give a fatal
error message if the selected serial port is not present at the beginning of the uploading phase
("Failed uploading: no upload port provided").

1. Connect the 3pi+ device to your computer via USB.

2. In the "Tools" menu, open the ?Board? sub-menu and select "Pololu A-Star 32U4".

3. In the "Tools" menu, open the "Port" sub-menu and check to see if any ports are selected.
If the "Port" menu is grayed out or no ports in it are selected, that is good, and you can
skip to step 6.

4. Reset the board by pressing twice on the reset button to get the board into
bootloader mode. While the board is in bootloader mode, quickly select the new serial
port that corresponds to the bootloader in the ?Port? menu.

5. After 8 seconds, the bootloader will exit and attempt to run the sketch again. Wait for
the bootloader to exit. Verify that either the ?Port? menu is grayed out or no ports in it
are selected.

6. Click the Upload button. The Arduino IDE will compile your sketch and start uploading
it.

7. As soon as the box near the bottom of the IDE says "Uploading?", reset the board twice
to get into bootloader mode.

The Arduino IDE will stay in the uploading phase for 10 seconds, waiting for a new serial port
to appear. Once the serial port of the bootloader appears, the Arduino IDE will connect to it
and send programming commands.

18


	Line tracking control & line maze solving strategies for the 3pi+ mobile robot
	A few short videos to start with
	Pre-lab questions
	The 3pi+ mobile robot from Pololu
	Hardware required
	Operating system and software required
	Identification of the physical system components of the 3pi+
	Test of a basic control in open loop
	Characteristics of the robot line following from a control system perspective
	Control performance requirements

	Control strategies for the robot line tracker on the basic test track
	Download of the files required for closed-loop control
	Test of a P controller in closed loop
	Test of a PD controller in closed loop
	Performance summary of the different controllers on the basic test track

	Control strategies for the robot line tracker on the racing competition track
	More sophisticated control strategies to improve performance
	Addition of dynamic speed variation
	Addition of an integral action in the controller

	Solving a line maze
	Troubleshooting
	If you cannot upload any script to the 3pi+ robot



